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Welcome to Protocol Manager
Protocol Manager, developed as a cooperative venture between the National Park 
Service and the Bureau of Reclamation, is a dynamic data dictionary that tracks the 
data structure, scientific basis, and metadata contained in a monitoring database. As a 
stand-alone database management tool, Protocol Manager streamlines management 
of protocols and field methods for data collection. This tool allows you to build protocols 
and methods within a flexible organizational structure and to add new attributes for a 
specific method.  

Using Protocol Manager within an organization can ensure that consistent 
methodologies and sampling protocols are applied across a project, which enhances 
the quality and consistency of the collected data over time. Protocol Manager also 
includes the ability to add technical references to document your protocols and 
methods. 

Protocol Manager is an independent component of the FFI Ecological Monitoring Utilities, 
a set of monitoring tools that is the integration of FEAT and FIREMON, two respected, 
science-based programs used for fire effects monitoring on public lands. Methods and 
protocols developed in Protocol Manager can be imported directly into FFI. 

Features  
o Uses a Database Administration module to create and store protocol databases. 

o Exports easily to FFI and other external databases and applications. 

o Offers a comprehensive reporting function. 

o Provides automated metadata support. 

Getting started 
To get started with Protocol Manager, proceed to: 

o About the User's Guide 

o Installing Protocol Manager 

o Reviewing Protocol Manager basics 

o Using Protocol Manager 

 Links  
o On-line Protocol Manager information at FRAMES 

o On-line users community at Google Groups 

There are three separate User's Guides available at FRAMES and on-line:  

o  FFI (main application) 

o Protocol Manager 

o GIS Module 
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About the User's Guide
The Protocol Manager User's Guide covers the following topics: 

o Installing Protocol Manager. 

o Creating, importing, and exporting databases. 

o Working with methods and protocols. 

o Adding and editing attributes. 

o Assigning methods to protocols. 

o Assigning protocols to projects. 

o Promoting methods and protocols from development to production. 

o Generating reports. 

 There are three separate User's Guides :  

o FFI (main application) 

o Protocol Manager 

o GIS Module 

Each User's Guide is available in three formats: on-line, as desktop help, and in PDF 
format. It will be updated as FFI is revised, and updates will be announced to the user 
community via the on-line FFI information page at frames.nbii.gov/ffi. 

NOTE: The Protocol Manager reports function was added late in the development 
stage. For this reason, most screen shots used in the documentation do not show the 
Reports menu item in the Protocol Manager toolbar. 

Conventions 

Text conventions used in this manual are explained below. 

CONVENTION DESCRIPTION EXAMPLE 

Bold Instruction 

Name 

Click Next. 

The Database Select window opens. 

Click the New Program icon. 

Select Import in the Database pull-down menu. 

Italic Value; option in a menu or 
listing 

Select the Tree Composition protocol in the 
displayed listing. 

NOTE Note Notes provide additional information pertinent 
to a topic. 

CAUTION Caution Cautions provide warnings. 

Blue underlined 
italics Internal links; Web links See Using organizations for more information.
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User's Guide roadmap 
Follow the links to reach the components of the Protocol Manager User's Guide: 

o Installation 

o Protocol Manager basics 

o Using Protocol Manager 

o Building reports 
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Getting additional help 
If you need help beyond the information provided in this User's Guide, visit the on-line FFI 
information page at frames.nbii.gov/ffi. This FRAMES page provides: 

o Information about the FFI ecological monitoring utilities. 

o Links to documentation and training information. 

o Links to other FRAMES pages. 

o Calendar of upcoming events. 

o Contact information for members of the FFI team. 

Also visit the on-line users community at Google Groups
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Installing Protocol Manager 
The flowchart below shows the four key processes involved in installing Protocol Manager 
and creating a database. Each process is described in a separate part. 

NOTE: You must have Windows administrator privileges to install Protocol Manager on 
your computer. A regular Windows user can use Protocol Manager after a Windows 
administrator has installed it. 

 

NOTE: The full installation process requires approximately one hour to complete. 

o Part 1 - Installing FFI and .NET 

o Part 2 - Installing SQL Server 2005 Express 

o Part 3 - Configuring a database using the Database Administration module 

o Part 4 - Opening FFI and logging on 

Part 1 – Installing Protocol Manager and Microsoft .NET 

 
The Microsoft® .NET Framework 2.0 is included in the FFI installation package. To install 
Protocol Manager and .NET, follow these steps: 

1. Uninstall any earlier versions of Protocol Manager using the Windows Add/Remove 
Programs function. (Do not uninstall SQL Server.) 

2. If you have not already done so, download the FFI installation package from the 
Software and Manuals page at FRAMES. 

3. Double-click the FFI Install.exe icon on your desktop. 

 
4. The InstallShield Wizard window opens and prepares to install. Click Next. 

NOTE: If the .NET 2.0 Framework is already installed on your computer, you will not see 
Step 5. Proceed to Step 6. 
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5. If the .NET 2.0 Framework is not installed on your computer, the InstallShield Wizard 
will prepare to install it. 

 
a. Wait while InstallShield downloads and installs .NET 2.0 Framework. This takes 

a few minutes. 

b. A dotnetfxModule Security Warning will ask “Do you want to run this 
software?”. Click Run. 

 
c. Wait while the InstallShield Wizard configures .NET 2.0 Framework. 

Configuration takes several minutes. 

d. You will be returned to the FFI InstallShield Wizard window. Click Next.  

 
6. Accept the license agreement terms and click Next. 
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7. In the Customer Information window, enter your User Name and Organization 
Name. Select the Anyone who uses this computer (all users) option and click Next. 

 
8. In the Ready to Install window, click Install. Protocol Manager will be installed. 

Icons for FFI, FFI Database Administration, and Protocol Manager will appear on 
your desktop. 

 
9. When installation is complete, click Finish. 

10. If you are asked to restart your computer, click Yes to restart before continuing. 

 
11. After your computer has restarted, proceed to Part 2, Installing SQL Server 2005 

Express Edition. 
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Part 2 – Installing SQL Server 2005 Express Edition 

 
To install SQL Server 2005 Express Edition on your computer: 

1. Navigate to http://msdn.microsoft.com/vstudio/express/sql/download/. 

NOTE: These installation instructions are written for Microsoft Internet Explorer. 

2. Click Download to download Microsoft SQL Server 2005 Express Edition to your 
computer, as indicated in the left-hand box below.  

 
3. Save the file to your desktop. 
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4. When the download is complete, click Run in the message window. 

 
5. In the security warning window, click Run. The installer extracts files needed for 

installation. This can take a few minutes. 
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6. Accept the licensing conditions and click Next. 

7. In the Installing Prerequisites window, click Install. Installation takes a few moments. 

8. Click Next after the required components are successfully installed. 

9.  In the System Configuration Check window, click Next. 

10. The Microsoft SQL Server Installation Wizard opens. Click Next.  

11. Another System Configuration Check window opens. Click Next. 

NOTE: If the System Configuration fails, contact your IT support staff. 

12. In the Registration Information window, complete the Name and Company fields. 
Uncheck the Hide advanced configuration options box, and click Next. 

 
13. In the Feature Selection window, click Next. Do not change any options. 
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14. In the Instance Name window, click Next to create your SQL Server instance. Do 
not change any options.  

 

NOTE: Click the Installed Instances button to see a listing of any instances that are 
already installed. If you already have SQL instances installed on your computer, you 
will need to enter a unique name for this new instance of SQL. Remember the new 
name; you will need it later in the installation. Otherwise, keep the default name as 
SQLExpress. 

15. In the Service Account window, leave the Use the built-in System account option 
checked, as shown. Select SQL Server and SQL Browser, and click Next. 
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16. In the Authentication Mode window, select the Mixed Mode option. Enter and 

confirm a new SQL password, and then click Next.  

 

NOTE: Select a password that you can easily remember, since it cannot be retrieved if 
it is forgotten. See Password guidelines for help in selecting a password. This is your sa 
user (SQL) password, and you will use it each time you log on to Protocol Manager. Be 
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sure to write your sa user password down in a safe place. Your sa user (SQL) password 
is different than your Windows password. 

17. In the Collation Settings window, click Next. Do not change any options. 

18. In the Configuration Options window, click Next. Do not change any options. 

19. In the Error and Usage Report Settings window, do not enter anything, and click 
Next. 

20. In the Ready to Install window, click Install. Installation and setup can take several 
minutes. 

21. In the Setup Progress window, click Next.  

22. In the Completing Setup window, click Finish.  

23. Proceed to Part 3, Configuring a database in SQL Server 2005. 

Part 3 – Configuring a database in SQL Server 2005 

 
Protocol Manager uses a SQL Server 2005 database to store protocols and methods. If a 
database is not already available for your project, you must create one before you can 
begin to work with Protocol Manager. Use the FFI Database Manager module to create 
a new database. 

1. Double-click the FFI Database Administration icon on your desktop. The Database 
Manager window opens. 

 
2. In the Connect pull-down menu, select SQL Server. 
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3. In the pull-down menu in the Server Login window, select the SQL server instance 

that you created in Part 2, step 16. Enter the username sa and the sa user 
password that you created (your SQL password). Click OK. 

 

NOTE: Unless you selected another name for the server in Part 2, step 14, the server 
instance is called SQLEXPRESS. 
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4. In the tree view of the Database Manager window, highlight the name of the SQL 
server instance. 

 
5. In the Server pull-down menu, select Create Database. Select Protocol Manager. 
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6. Enter a unique name, such as a park or forest name, for the new Protocol 

Manager database and click OK.  

 

NOTE: If a database with the name that you selected already exists, Protocol 
Manager will prompt you to enter a different name or to overwrite the existing 
database. Database names cannot contain spaces and must begin with an 
alphabetic character. 

7. A DOS window and a progress bar open, as shown below. Wait while the 
database is created, which could take several minutes, depending on your 
computer. 
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8. In the tree view of the Database Manager window, open the Databases folder. The 

new database will be listed. 

 20



 
9. Close the Database Manager window. 

10. Proceed to Part 4, Opening Protocol Manager and logging on. 

Part 4 – Opening Protocol Manager and logging on 

 
To log on and begin using Protocol Manager: 

1. Double-click the Protocol Manager icon on your desktop, or launch Protocol 
Manager from your Start menu (Start/Programs/FFI/Protocol Manager). 

 
2.  The Database Select window opens. 
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NOTE: The Protocol Manager splash screen may be visible for a moment or so while 
the program loads. 

3. In the Database Select window, select your SQL server instance using the pull-
down menu. Enter the username sa and the sa user (SQL) password that you 
established in Part 2. 

NOTE: The server name is in the format machinename\SQLEXPRESS.  
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4. In the Connect to a database pull-down list, select the database that you created, 

and click OK. 

NOTE: If the Connect to a database menu is grayed out and you cannot select a 
database, you have entered an incorrect SQL password. Log on to the server again 
with the correct password. If necessary, repeat the Configuring a database 
procedure (Part 3). 

5. Protocol Manager will open and the new database will be connected. 

6. Proceed to Using Protocol Manager. 

Password guidelines 
For security, new Protocol Manager passwords should meet the following guidelines: 

o The password does not contain all or part of the username. 

o The password is at least eight characters long. 

o The password contains characters from three of the following four categories: 

 Uppercase letters A through Z. 

 Lowercase letters A through Z. 

 Numerals 0 through 9. 

 Non-alphanumeric characters such as !, $, #, or %. 
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Protocol Manager basics 
This section of the User's Guide presents key definitions and concepts: 

o Term definitions 

o Data field definitions 

o Protocols and methods: development vs. production status 

o Navigating in Protocol Manager 

When you're ready, proceed to Using Protocol Manager. 

Definitions 
Protocol Manager uses a unique set of definitions that are readily adaptable to any 
ecological monitoring program: 

o Project – a collection of monitoring sites within a specific geographic region, such 
as a watershed or subbasin, for which monitoring data is collected based on 
established, approved protocols.  

o Program – a collection of projects that use a consistent set of protocols to collect 
monitoring data for specific sites within multiple geographic locations in response 
to a research question, or to meet an agency mission or mandate. 

o Protocol – a set of one or more closely related methods, compiled by a 
researcher, monitoring agency, or other entity, that are used to collect, analyze, 
and report field monitoring data in a consistent way over time. Protocols are a 
means of organizing methods in terms of common or related characteristics, so 
that they can be efficiently filtered and located. A protocol can contain one or 
more methods, and methods may occur in one or more protocols. 

o Method – a systematic procedure for collecting, analyzing, or reporting monitoring 
data consistently over time. Methods have these characteristics: they can be 
replicated by others and are described in documentation. In Protocol Manager, it 
is assumed that methods are contained within protocols, but this is not required. 
Methods can be created and maintained without protocols. Also, a method may 
occur in more than one protocol. 

o Attribute – a quantitative field measurement or summary value, or a qualitative 
descriptor, that represents conditions observed in the field. 

This hierarchy is shown in the graphic below. 
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NOTE: See Data field definitions for additional information on these definitions. 

Data field definitions 

Program builder 

FIELD NAME DEFINITION 

Program name Name assigned to program 

Objective Overall program objective 

Description Description of key elements of program 

Contact Contact information for primary contact person associated with 
program 

Project builder 

FIELD NAME DEFINITION 

Program Name of the program with which the project is associated 

Project name Name assigned to project 

Objective Overall program objective 

Description Description of key elements of project 

Contact Contact information for primary contact person associated with 
project 

Protocol builder 

FIELD NAME DEFINITION 

 25



Protocol name Name assigned to protocol 

Description Description of key elements of protocol 

Contact Contact information for primary contact person associated with 
program 

Version history Automatically registered by Protocol Manager to track history of 
changes to the protocol 

Method builder 

FIELD NAME DEFINITION 

Method name 
Name assigned to method 

Unit system Unit system to be applied to the method 

Method shape Shape of the area to which the method is to be applied 

Single record Whether or not the method is composed of a single record for 
data collection 

Description Description of key elements of the method 

Organizations 
Type of data indicator or indicator group associated with the 
method 

Version history Automatically registered by Protocol Manager to track history of 
changes to the method 

References References listed in the method - can be books, Web sites, or 
journals 

Sample attribute builder 

FIELD NAME DEFINITION 

Value definition 
  

• Unit Unit in which the attribute is measured or recorded 

• Data type Type of data collected, or type of field necessary to house data 

• Precision Number of decimal places to which the data is measured 

• Read only Whether or not a user can modify the data 

• Limit codes to list Whether or not the data in the field is limited to a list of specific 
values 

• Default value A value assigned as a default that will automatically populate a 
field unless the user specifies another value 

• Minimum value Minimum acceptable value 

• Maximum value Maximum acceptable value 

• Value length Number of characters that can be contained in the value field 

• Allow null Whether or not the user can leave the field blank 

• Visible Whether or not the user sees the data entry field, or if it is used 
for data management separate from data collection 

• Data level Geographic extent to which the data is representative or to 
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which the data can be extrapolated, e.g., reach, basin, 
watershed 

Codes Abbreviations or codes used to represent a longer description or 
text, e.g., CHN = Chinook 

Description Description of sample attribute and process of data collection 

Method attribute builder 

FIELD NAME DEFINITION 

Value definition 
  

• Unit Unit in which the attribute is measured or recorded 

• Data type Type of data collected, or type of field necessary to house data 

• Precision Number of decimal places to which the data is measured 

• Roll down   

• Limit codes to list Whether or not the data in the field is limited to a list of specific 
values 

• Default value A value assigned as a default that will automatically populate a 
field unless the user specifies another value 

• Minimum value Minimum acceptable value 

• Maximum value Maximum acceptable value 

• Value length Number of characters that can be contained in the value field 

• Allow null Whether or not the user can leave the field blank 

• Visible Whether or not the user sees the data entry field, or if it is used 
for data management separate from data collection 

• Data level Geographic extent to which the data is representative or to 
which the data can be extrapolated, e.g., reach, basin, 
watershed 

Codes Abbreviations or codes used to represent a longer description or 
text, e.g., CHN = Chinook 

Description Description of sample attribute and process of data collection 

  

Development vs. production status 
In Protocol Manager, protocols and methods are classified as either Development or 
Production. 

o Development denotes a draft, or in-process, state. Protocols and methods in 
Development can be edited or deleted. 

o Production denotes a final, or approved, state. After promotion, protocols and 
methods cannot be edited or deleted. 

NOTE: If you collect field data using a Development method, the data will not be 
saved. Data is not saved as final until the method is promoted to Production. 

 27



When Protocol Manager imports a database, its protocols and methods are classified as 
Development. Likewise, all protocols and methods that you create are classified as 
Development. As you finalize and approve your methods, you can promote them to 
Production. Once all methods contained within a protocol are promoted, you can 
promote the protocol to Production. After promotion, the protocol cannot be edited or 
deleted. The methods, their attributes, and any data associated with the methods will be 
locked. 

CAUTION: All methods within a protocol must be promoted before the protocol can 
be promoted. 

A yellow triangle is used to designate Development protocols and methods, as shown 
here. After promotion, the yellow triangle no longer appears. In this example, the 
protocol Tree Density and its methods TDensity Method1 and TDensity Method2 have 
been promoted to Production. 

 

NOTE: If you need to modify a protocol or method that has been promoted to 
Production, you can duplicate the protocol or method. The duplicates will then be in 
Development and can be edited. 

Navigating in Protocol Manager 
Most Protocol Manager functions provide three ways of navigating. 

Pull-down menus 

Pull-down menus are available on the main Protocol Manager toolbar. To use some 
menus, you must be in the appropriate view. For example, you must be in the Protocols 
view to use the Protocols pull-down menu. 

 

Right-clicking 

Right-clicking an item, such as a method, brings up a menu of available actions. 
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Toolbar icons 

Toolbar icons within the Programs & Projects, Protocols, and Methods views provide short-
cuts for the actions available. Mouse over the icons to view their labels. 
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Using Protocol Manager 
This section of the Protocol Manager User's Guide covers: 

o Using databases 

o Working with programs and projects 

o Working with protocols 

o Working with methods 

o Adding attributes to methods 

o Using filters to organize information 

o Managing organizations 

o Managing references 

o Checking for errors 

o Opening log files in the Help menu 

o Building Protocol Manager reports 

NOTE: The Protocol Manager reports function was added late in the development 
stage. For this reason, most screen shots used in the documentation do not show the 
Reports menu item in the Protocol Manager toolbar. 
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Using databases in Protocol Manager 
Protocol Manager uses databases to store protocols and methods. If a database is not 
available for your project, you must create one before you can begin to work with 
Protocol Manager. Databases can also be imported and exported. 

Use the Database Administration module to create, update, delete, back up, and 
restore databases. The module was installed on your computer during the Protocol 
Manager installation process. 

For information, see: 

o Creating a database 

o Exporting a database 

o Importing a database 

Creating a database 
Use the following procedure to create a new database: 

1. Double-click the Database Administration icon on your desktop or launch the 
application from the Start menu. 

2. In the Connect pull-down menu, select SQLServer. 

 
3. In the Server Login window, select your SQLEXPRESS server instance from the drop-

down list. Enter the username sa and your SQL password. 
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continued

Creating a database (continued) 
4. In the Server pull-down menu, select Create Database, and then select Protocol 

Manager. 

 
5. Enter a unique name for the new database and then click OK. 
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NOTE: If you add a new database with the same name as an existing database, the 
new database will replace the existing database. Be sure to use unique names for 
your databases. 

6. A DOS window and a progress bar will open. Database creation will take a few 
moments. 

  

Exporting a database 
You can export your Protocol Manager database for use in FFI or other applications. 

NOTE: Exported databases are XML files with a .pmd extension. The default file name is 
FFI_PM_Export.pmd. 

To export a database: 

1. Select Export in the Database pull-down menu. Then select All Data or Single 
Project. 
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2. In the pull-down list, highlight the project to be exported. Click Export. 

 

NOTE: This screen will not appear if you select All Data. 

3. A Save As window opens. Accept the default file name or enter another name, 
and click Save. 
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See also Importing a database.  

NOTE: If necessary, you can also review Importing a .75 schema. 

Importing a database 
You can import a Protocol Manager database constructed by another Protocol 
Manager user, or one that represents a different administrative unit. Databases to be 
imported must be XML files with a .pmd extension. 

To import a database: 

1. Select Import in the Database pull-down menu. 
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2. In the Open window, browse to and select the file to be imported. Click Open. 

 
3. A confirmation window opens. Click Yes to accept the file import. 
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NOTE: If you decline, your database will not be touched. 

See also Exporting a database. 

Using filters to view and organize information 
Filters are useful to dynamically sort protocols and methods that possess specific 
characteristics. In Protocol Manager, you can assign organization groups (main 
categories) and organizations (sub-categories) to define and classify your methods and 
protocols. The filters in Protocol Manager correspond to the organizations that you assign.  

NOTE: See Managing organizations for information about using organization groups 
and organizations to describe and categorize your methods and protocols. 

Filter icons are shown on the toolbar when you are in either the Protocols or Methods 
view. 

1. Use the Filters pull-down menu to select filters. Once you have selected your filters, 
click the right-hand Filter icon (circled). 
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2. In the Filtering window, select filter criteria within each of your chosen filters. 

3. Following is a list of methods filtered for the Domain Field Sample. Four methods 
were found. Indicator Group and Source Program were also selected in Filters, but 
were not filtered.  
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Importing a .75 Protocol Manager schema 
NOTE: These instructions pertain only to RME Protocol Manager users. If you are an FFI 
user, disregard this section. 

1. In the Database Manager window, click Import .75pdb in the Update pull-down 
menu. 
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2. To connect to your existing Protocol Manager database, click Connect .75 

Database in the .75 Beta to 1.0.0.1 Alpha window. 

 
3. Log into the appropriate SQL server and select your existing .75 database. 
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continued

Importing a .75 Protocol Manager schema (continued) 
4. In the .75 Beta to 1.0.0.1 Alpha window, click Translate. 
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5. In the Import? pop-up window, click Yes. 

 
6. When the import is complete, click OK. 

 
7. Close the FFI Database Administration module. 
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Working with programs and projects 
Use the Programs and Projects pull-down menus while in the Programs & Projects tab to 
build a framework for your Protocol Manager database. 

NOTE: The functions available on the pull-down menus correspond to the small icons 
in the Programs & Projects toolbar. 

 
The available Programs & Projects functions are: 

o Adding a new program 

o Adding a new project 

o Editing a program or project 

o Deleting a program or project 

o Reviewing a program or project's properties 

o Adding or removing project protocols 

Adding a program 
In Protocol Manager, a program is a collection of projects that use a consistent set of 
protocols to collect monitoring data for specific sites within multiple geographic 
locations. 

To add a new monitoring program to the database: 

 43



1. In the Programs pull-down menu, select New. You can also click the New Program 
icon at the left of the toolbar to add a new program. 

 
2.  In the Program Builder window, enter information describing the new program. 

When you're finished, click Save & Close. 

NOTE: The Objective and Description text fields can accommodate up to 400,000 
characters. You can cut and paste text into these fields. 
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3. The new program Burnham Woods is now listed in the tree view. Note that this 
program does not yet contain a project. 

 
See Adding a project.

Adding a project 
In Protocol Manager, a project is a collection of monitoring sites within a specific 
geographic region, such as a watershed or subbasin, for which monitoring data is 
collected based on established, approved protocols. 

To add a new project to a monitoring program: 

1. In the Projects pull-down menu, select New, or click the Add a new project icon on 
the toolbar.  
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2. The Project Builder window opens. Select the program in the pull-down menu. 

Name the new project and enter any descriptive information. When you're 
finished, click Save & Close. 

NOTE: The Objective and Description text fields can accommodate up to 400,000 
characters. You can cut and paste text into these fields. 
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3. The new project Burnham Unit 1 is listed in the tree view within the program 
Burnham Woods. 

 
See also: 

Assigning protocols to a project

Editing programs and projects 
Procedures for editing programs and projects are very comparable. In this example, a 
program is being edited. To edit: 

1. Right-click the program or project name in the tree view and select Edit Program. 
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2. The Program Builder or Project Builder opens. Make necessary changes and 

additions, and click Save & Close. 
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Reviewing program or project properties 
Procedures for reviewing program and project properties are very comparable. In this 
example, program properties are being reviewed. To review: 

1. Right-click the program or project name in the tree view and select Program 
Properties. 

 
2. The Program Properties or Project Properties window opens. When finished, close 

the window. 

 

NOTE: You cannot change properties in this window. Use the Edit function to change 
properties. 
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Deleting programs and projects 
Use caution when deleting programs and projects, since you will lose protocol 
relationships as well as the project and program. 

Procedures for deleting programs and projects are very comparable. In this example, a 
program is being deleted. 

NOTE: You must confirm deletion of programs and projects that are associated with 
protocols and methods. 

To delete: 

1. Right-click the program or project name in the tree view and select Delete 
Program. 

 
2. Read the information in the Delete Program window. Click Yes or No to delete or 

retain the program or project. 
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Working with protocols 
A protocol is a set of one or more closely related sampling methods that are used to 
collect, analyze, and report field monitoring data in a consistent way over time. 
Protocols are a means of organizing methods in terms of common or related 
characteristics, so that they can be efficiently filtered and located. 

Use the Protocols pull-down menus while in the Protocols tab to create, modify, and 
organize your protocols. 

NOTE: The functions available on the pull-down menus correspond to the small icons 
in the Protocols toolbar. 

 
The available Protocols functions are: 

o Adding a new protocol. 

o Editing a protocol. 

o Adding and removing methods. 

o Assigning protocols to projects. 

o Deleting a protocol. 

o Duplicating a protocol. 

o Promoting a protocol. 

o Viewing protocol properties. 

Adding a new protocol 
To add a new protocol to a database: 
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1. Highlight the appropriate program or project in the main Protocol Manager 
window. 

2. Click the Protocols tab to switch to the Protocol view. 

3. In the Protocols pull-down menu, select New. You can also click the New Protocol 
icon at the left of the toolbar to add a new protocol. 

 
4. Enter a name and description for the new protocol. Here, the hypothetical 

protocol Tree Stand Composition is being added. If you wish, you can also add 
contact information (version history is added automatically). Click Save & Close 
when finished. 
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NOTE: The Description text field can accommodate up to 400,000 characters. You 
can cut and paste text into these fields. 

5. The Version Builder window opens. If you wish, you can add additional descriptive 
information here. Click Save to finish adding the new protocol. 

 
continued

Adding a new protocol (continued) 
5. The new protocol Tree Stand Composition is now included in the Protocols list. As 

indicated by the yellow triangle, Tree Stand Composition is classified as 
Development. 
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As shown, no methods are attached to the protocol. Also, the protocol is not assigned to 
a project. 

o To add methods to a protocol, see Assigning methods to a protocol. 

o To assign the protocol to a project, see Assigning protocols to a project. 

Editing protocols 
Protocols that are still in Development can be edited.  

1. Highlight the protocol in the Protocols view. 

2. Select Edit in the pull-down menu, or click the Edit the selected protocol properties 
icon in the toolbar. 

 54



 
3. The Protocol Builder window opens. Make necessary edits or add additional 

information, and click Save & Close. 
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Promoting protocols 
Once all methods contained within a protocol been accepted and promoted, the 
protocol can be promoted from Development to Production. At that point, it can no 
longer be edited. 

NOTE: See Development and Production status for further information. 

1. Highlight the protocol in the Protocols view.  

2. Select Promote in the pull-down menu or click the Promote the selected protocol 
to production icon in the toolbar. 

 
3. The Version Builder window opens. Enter a notation in the Description field and 

click Save. 
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4. The promoted protocol appears in the Protocols listing.  

 

NOTE: All methods contained within a protocol must be promoted before the 
protocol can be promoted. 

Assigning a protocol to a project 
After you create a new protocol, you can assign it to a project. You can also assign a 
protocol that exists in one project to another project. 

To assign a protocol to a project: 

1. In the main Protocol Manager window, switch to the Programs & Projects view. 
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2. Right-click the project name and select Add/Remove Project Protocols. Or, click 
the icon in the toolbar. 

 
3. The Project Protocol Selector window opens. Double-click the desired protocol 

(Fuel Load in this example) in the Available Protocols box to add it to your project. 
You can also select the protocol and use the right arrow to shift it to the project. 
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4. Click Save & Close. 

After you save and close, the protocol Fuel Load is assigned to the Bandit project.  

Additional protocol functions 
This section addresses additional functions that are accessible from the Protocols pull-
down menu while in the Protocols tab. 

Deleting a protocol 

Only protocols that do not have assigned methods can be deleted. To delete a 
protocol: 

1. Right-click the protocol in the tree view and select Delete. 

2. If the protocol is eligible for deletion, you will be asked to confirm the deletion. In 
the confirmation window, click OK. 

Duplicating a protocol 

To duplicate a protocol: 

1. Right-click the protocol name in the tree view and select Duplicate. 

2. Assign a name for the new protocol in the Protocol Name box and click OK. 
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Viewing protocol properties 

To view the properties that are assigned to a protocol: 

1. Right-click the protocol name in the tree view and select Protocol Properties. 

2. Review the properties in the Protocol Properties window and close the window 
when done. 

NOTE: You cannot modify properties in this window. 
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Working with methods 
In Protocol Manager, a method is a systematic procedure for collecting, analyzing, or 
reporting monitoring data consistently over time. Methods can be replicated by 
others, and they are described in documentation. Methods are first added to 
Protocol Manager and then assigned to protocols. 

Use the Methods pull-down menu while in the Methods tab to create, modify, and 
organize your methods. 

NOTE: The functions available on the pull-down menus correspond to the small icons 
in the Methods toolbar. 

 
Tips for working with methods:  

o Method attributes and sample attributes are required to follow certain naming 
conventions for field names. See Naming conventions for more information. 

o Method text fields, like those for protocols and attributes, can accommodate up 
to 4,000 characters. 

o A value field can accommodate 100 characters. 

The available Methods functions are: 

o Adding a new method. 

o Editing a method. 

o Deleting a method. 

o Duplicating a method. 

o Exporting a method. 

o Promoting a method. 

o Viewing method properties. 
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o Viewing method attribute properties. 

To assign a method to a protocol, see Assigning a method to a protocol. 

Adding a new method 
To add a new method to a Protocol Manager database: 

1. Click Methods to switch to the Methods view. 

2. Select New in the Methods pull-down menu, or click the Add a new method icon 
at the left side of the toolbar. 

 
3. The Method Builder window opens. Follow the steps below to describe the new 

method. 
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a. Name. Enter a name for the new method. In this example, the new method 

is TSComposition Method1. 

b. Specify the Unit System. Choices are metric, English, or mixed. 

c. Specify the Method Shape. This is a simple geometric description of the 
sample area on the ground. 

d. Single Record. This tells FFI how many records can be added. True limits 
record entry to a single entry and results in a singer record, vertical column, 
entry screen for data capture. Set this to True for methods in which you will 
be creating only one method attribute record in the database. As an 
example, tallying particles in three size classes yields one record with three 
fields, rather than three records. Another example is the Plot Description 
method, where a number of single observations are recorded for a macro 
plot. 

NOTE: If you select False, meaning multiple records can be added, Protocol Manager 
will add an attribute called Index, which is not editable. Disregard it. If you select True, 
the Index attribute does not appear. 

Next, enter information into the Method Properties tabs. 

continued
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Adding a new method (continued) 
5. Add supplemental information describing the method using the Method Properties 

tabs. 

a. Sample Attributes and Method Attributes: Incorporate sample and method 
attribute information into the new method. See Adding attributes for 
detailed information. 

b. Organizations: Add information about the organization to which the method 
or protocol is assigned. Organizations provide a way to categorize and filter 
methods and protocols based on the methods a protocol contains. See 
Managing organizations and Filtering methods and protocols for more 
information. 

c. Description: Add a brief written description of the method. The Description 
text field can accommodate up to 400,000 characters. You can cut and 
paste text into these fields. 

d. References: Attach technical references to substantiate the method. 
References that are constructed using the Reference Manager in the 
Tools pull-down menu can be directly assigned to the method through the 
References tab. 

e. Version History: Protocol Manager automatically assigns a version stamp 
when a method is created and each time that it is updated. 

6. Click Save & Close when finished. 

7. The Version Builder window opens. Enter a brief description and click Save. 

 
8. TComposition Method1 is now included in the Methods list.  

NOTE: The yellow triangle shows that TComposition Method1 is a Development 
method.
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NOTE: The new method is not assigned to a protocol at this point. Once you have 
assigned the method to a protocol, it will appear in the Protocols tab. 

See Assigning a method to a protocol. 

Editing methods 
Methods that are still in Development can be edited.  

NOTE: See Development and Production status for further information. 

1. Right-click the name of the method in the Methods view and select Edit Method, or 
click the Edit the selected method icon at the left side of the toolbar.  
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2. The Method Builder window opens. Make the necessary edits or text additions and 

click Save & Close. 
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Assigning a method to a protocol 
To assign a method to a protocol in Protocol Manager: 

1. Click Protocols to switch to the Protocols view. 

2. Select the appropriate protocol in the displayed listing. Here, the Species 
Composition protocol is selected.  

3. Select Add/Remove Protocol Methods in the Protocols pull-down menu, or click the 
Add/Remove Protocol Methods icon in the toolbar. 
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4. The Protocol Method Selector window opens. Double-click the desired method in 

the Available Methods box to move it into the Methods box. In this example, Point 
Cover - Points is being added to the protocol Biomass. 
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5. When you are done, click Save & Close. 

Promoting methods 
Once a method has been finalized and accepted, it can be promoted from 
Development to Production. At that point, it can no longer be edited. 

NOTE: See Development and Production status for further information. 

 Right-click the name of the method in the Methods view and select Promote 
Method, or click the Promote the selected method icon at the left side of the toolbar. 
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1. The Version Builder window opens. Enter a notation in the Description field and 

click Save. 

 
2. The promoted method appears in the Methods listing.  

 70



 

NOTE: All methods contained within a protocol must be promoted before the 
protocol can be promoted. 

Additional method functions 
This section addresses additional functions that are accessible from the Methods pull-
down menu while in the Methods tab. 

Exporting a method 

You can export a method as a *.pmd (Protocol Manager data) file so that it can be 
imported into another Protocol Manager database or into FFI. To export a method: 

1. Right-click the method name in the tree view and select Export. 

2. A Save As window opens. Assign a name and file location for the method to be 
exported and click Save. 

Deleting a method 

Only methods that are not associated with protocols can be deleted. To delete a 
method: 

1. Right-click the method in the tree view and select Delete. 

2. If the method is eligible for deletion, you will be asked to confirm the deletion. In 
the confirmation window, click OK. 
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Duplicating a method 

To duplicate a method: 

1. Right-click the method name in the tree view and select Duplicate. 

2. Assign a name for the new method in the Method Name box and click OK. 

Viewing method properties 

To view the properties that are assigned to a method: 

1. Right-click the method name in the tree view and select Method Properties. 

2. Review the properties in the Method Properties window and close the window 
when done. 

NOTE: You cannot modify properties in this window. 

Viewing method attribute properties 

To view the properties that are assigned to an attribute: 

NOTE: You cannot modify attribute properties in this window. 

1. Click the Methods pull-down menu in the Methods tab and select Attribute 
Properties. 

2. Review the properties in the Attribute Properties window and close the window 
when done. 

Adding attributes 
You can add method attributes and sample attributes to any method that is still in 
Development. Once a method has been promoted to Production, it can no longer be 
modified. 

o Sample attributes describe the conditions associated with a particular sampling 
event, such as date and time, plot and sample size, weather, names of sampling 
team members. These attributes are generally collected once per sampling event. 
See Adding sample attributes. 

o Method attributes describe the data being collected and analyzed, such as 
species count, tree size, tree density, fuels, and diversity. These attributes are 
generally collected more than once per sampling event. See Adding method 
attributes. 

NOTE: See Data field definitions for additional information on method and sample 
attributes. 

Protocol Manager uses the same general procedure to add both method and sample 
attributes, although the attribute data entry forms differ. 

Tips: 
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o Field names for method and sample attributes must follow naming standards. See 
Naming conventions for more information. Captions do not need to follow the 
requirements for field names. 

o Attribute text fields, like those for protocols and methods, can accommodate up 
to 4,000 characters. 

o A value field can accommodate 100 characters. 

o The term Precision, in the Attribute Builder > Value Definition tab, is used to indicate 
the number of decimal places that the record can accommodate. 

o The term Limit Codes to List, in the Attribute Builder > Value Definition tab, if True, 
means that the user can only select from the codes that were defined on the 
Method Attribute Builder > Codes tab, when doing data entry. 

o The term Roll-Down, in the Method Attribute Builder > Value Definition tab, if True, 
means that the value from the previous row 'rolls down' to be the default value for 
the new row. 

o The term Visible, in the Attribute Builder > Value Definition tab, sets whether or not 
the user will see the attribute field in FFI. 

Naming conventions 
In Protocol Manager, the field names for method attributes and sample attributes should 
be brief and must follow certain naming requirements to avoid conflicting with 
SQL Server standards. Field names can use: 

o Letters, either upper or lower case. 

o Numerals. 

o Underscores _. 

However, as you notice in the screen shot below, these requirements do not apply to 
captions, which can use more descriptive and meaningful terms. For example, the 
caption for the field name OS_Mean is Overstory Mean. When you click Preview Data 
Entry to see the data entry form for the method, you see that the data entry field is 
labeled with the caption, rather than the field name. 
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Adding method attributes 

NOTE: See Data field definitions for additional information on method and sample 
attributes. 

To add method attributes: 

1. Click the Methods tab and highlight the desired method in the tree view. 

2. Right-click on the method name and select Edit Method. The Method Builder 
window opens. In this example, the method is Cover - Line Intercept2. 

 
3. Click the Method Attributes tab. 

4. Click the Add Attribute icon (circled in the example above). The Method Attribute 
Builder window opens. This window contains three screens, as listed here. Examples 
of each screen from a working protocol database are shown below for illustration. 

NOTE: Field names for method attributes must follow naming standards. See Naming 
conventions for more information. Captions do not need to follow the requirements 
for field names. 

o Value Definition, which requests specific value data for the attribute, such as units, 
level of precision, values. 
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o Codes, where you can enter codes, such as species or height codes, that will be 
used in the data entry forms for the method. 

o Description, an open text field with a 4,000-character maximum, that can be used 
to enter a brief description of the method attribute. 
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5. Enter method attribute data as required. 

6. When you are finished, click OK & Close. 
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7. If you wish, click the Preview Data Entry button in the main Method Attribute Builder 
window to see a representative view of the data entry form that was created. 

See also: Editing attributes

Adding sample attributes 

NOTE: See Data field definitions for additional information on method and sample 
attributes. 

To add sample attributes: 

1. Click the Methods tab and highlight the desired method in the tree view. 

2. Right-click on the method name and select Edit Method. The Method Builder 
window opens. In this example, the method is Cover - Line Intercept2. 

 
3. Click the Sample Attributes tab. 

4. Click the Add Attribute icon (circled in the example above). The Sample Attribute 
Builder window opens. This window contains three screens, as listed here. Examples 
of each screen from a working protocol database are shown below for illustration. 

NOTE: Field names for sample attributes must follow naming standards. See Naming 
conventions for more information. Captions do not need to follow the requirements 
for field names. 
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o Value Definition, which requests specific value data for the attribute, such as units, 
level of precision, values. 

o A Codes field, in which you can enter codes, such as numbers or units of measure, 
that will be used in the data entry forms for the method. 

o Description, which is an open text field with a 4,000-character maximum. 
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5. Enter sample attribute data as required. 

6. When you are finished, click OK & Close. 

7. If you wish, click the Preview Data Entry button in the main Method Attribute Builder 
window to see a representative view of the data entry form that was created. 

See also: Editing attributes

Editing attributes 
The attributes of a method that is in Development can be edited. Methods that have 
been promoted to Production cannot be modified. 

To edit method or sample attributes for a method: 

1. Click the Methods tab and highlight the desired method in the displayed listing. 

2. Right-click on the method name and select Edit Method. The Method Builder 
window opens. 

3. The Method Builder screen is displayed. Select the Method Attributes or Sample 
Attributes tab.  

 
4. Right-click the attribute to be edited and select Edit Attribute.  
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NOTE: Other icons in this toolbar allow you to add a new attribute, delete an attribute, 
or view an attribute's properties. 

continued

Editing attributes (continued) 
5. The Method Attribute Builder or Sample Attribute Builder window opens, showing 

the current values for the selected attribute. 
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6. Modify attribute data as required. 

7. When you are finished, click OK & Close.  

For more information about attributes, see Adding attributes. 
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Building Protocol Manager reports 
NOTE: The Reports feature was added after the 1.0 release of Protocol Manager and 
is documented only in this portion of the documentation. Although the main Protocol 
Manager window has changed to include the new menu button, no existing 
functionality has changed. 

This section of the Protocol Manager documentation explains how to generate reports 
about your programs, projects, protocols and methods, and organizations, based on the 
information and data that were supplied when the record was created or edited. For 
example, you can create a report describing a particular project unit and the monitoring 
protocols that the project unit contains. To supplement the report, you can generate a 
method report, identifying and describing the specific methods attached to the 
protocols. If you have applied an organization structure to categorize your protocols and 
methods, you can create organization reports as well.  

When you create reports, you can select options about the scope and the level of detail 
that you wish to see. Three formats are supported for each report: no description, brief 
description, and complete description. Reports are generated as RTF (rich text format) 
files and are viewable in Microsoft Word or a text editor. In Word, you can reformat the 
reports to meet your own requirements. 

For detailed information on each of the reports, see: 

o Program, Project, and Protocol report procedure and sample. 

o Method report procedure and sample. 

o Organization report procedure and sample. 

TIP: To build a complete program or project notebook, generate a Program, Project, and 
Protocols report and open it in Word. Insert page breaks after each protocol, and print 
the report. Then generate and print a complete Methods report and interleave the 
methods pages to follow the correct protocols. If appropriate, generate and print an 
Organizations report and add it at the end of the notebook.

Program, Project, and Protocol reports 
A Program, Project, or Protocol report (see sample report) presents details for each 
selected element. Fields included in these reports include:  

o Program name, contact information, description, and objective. 

o Project name, contact information, description, and objective. 

o Protocol name, contact information, description, version history, and included 
methods. 

Generating the report 

To generate a Program, Project, or Protocol report: 

1. Reach the Reports menu through the main Protocol Manager toolbar. 
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2. Select Program, Project, and Protocol Reports. 
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3. Select the scope of the report by right-clicking on the program, project, or 
protocol name. 

o In this example, to include a program and all of its projects and protocols, highlight 
the program name and right-click. In the menu, click Recursive Select. The 
program and all of its projects and protocols will then be checked in the tree view.  

 
o To include the program and only certain projects and protocols, right-click and 

select Recursive Deselect in the menu. None of the underlying projects and 
protocols will be checked, and you can select only the ones you wish to include in 
the report. In this example, the project FFI - English and the protocols CBI, Density - 
Belts and Quadrats, and Plot Description are selected for reporting. 
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4. Select the options for the report. In this example, the report is for the program FFI 
and its project and protocols. The report will include complete text for the 
description fields and the first 5,000 characters of the Objectives fields. 

 
5. When you are ready, click Generate Report. 

 
6. In the Save As box, add the name and file location for the report, and click Save. 

See the sample report. 

You can open the report in a text editor, or open it in Word to reformat it to meet your 
requirements. 

NOTE: Any fields that do not contain data are reported as NULL. 
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Sample Program, Project, and Protocol report 

A sample of the Program, Project, and Protocol report is shown below. Fields for which no 
information is available are shown as Null. 
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Method reports 
A Method report presents details for each selected method. Fields included in these 
reports include: 

o Method name. 

o Basic information: unit system, single record true/false, method shape. 

o Version history. 

o Description - brief, complete, or not displayed. 

o Production status. 

o Application of method - identification of projects and protocols that use the 
method. 

o Sample attribute data - detailed or not displayed. 

o Method attribute data - detailed or not displayed. 

NOTE: Depending on the attribute option that you select, your method report may be 
quite lengthy. You may see a progress bar while the report is processing. 

Generating the report 

To create a Method report: 

1. Reach the Reports menu through the main Protocol Manager toolbar. 
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2. Select Method Reports. 

 
3. Use the Recursive Select or Recursive Deselect right-click menu items to select the 

methods to be reported. See Generating reports for more information. 

4. Select the options for the report. When you are ready, click Generate Report. See a 
sample report. 
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NOTE: If you opt to include detailed information for method attributes, your report will 
be lengthy and will take a few minutes to process. 

5. In the Save As box, add the name and file location for the report, and click Save. 

You can open the report in a text editor, or open it in Word to reformat it to meet your 
requirements. 

NOTE: Any fields that do not contain data are reported as NULL. 

Sample Method report 

A sample of the summary-level Method report is shown below. For brevity, the first report 
sample was generated using the Overview method attribute option and does not show 
the comprehensive sample and method attribute data that a complete report would 
contain. 

The second sample indicates the level of detail available when the Detailed method 
attribute option is selected. When you apply this option, the sample and method 
attribute information is shown between Description and Production Status, as shown by 
the arrow below. 

Fields for which no information is available are shown as Null. 

 92



 
  

 

Organization reports 
In Protocol Manager, you can apply an organization structure to categorize your 
methods and protocols based on subject, discipline, domain, or other criteria (for more 
information, see Managing organizations). An Organization report presents information 
about each organization or organization group that you set up for your programs and 
projects. Fields included in these reports include:  

o Organization name and description. 
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o Organization group name and description. 

o Identification of methods that use the organization. 

Generating the report 

To generate an Organization report: 

1. Reach the Reports menu through the main Protocol Manager toolbar and select 
Organization Reports. 

2. Check the organizations to be reported and select options for the report. When 
you are ready, click Generate Report. 

 
3. In the Save As box, add the name and file location for the report, and click Save. 

You can open the report in a text editor, or open it in Word and reformat it to meet your 
requirements. 

NOTE: Any fields that do not contain data are reported as NULL. 

Sample Organization report 

Two sample entries in an organization report are shown below. In this example, the 
organizations are Fuels and Site Description, and because no descriptions were supplied 
for these organizations, the description fields are Null. The methods that use the 
organizations are also listed. 
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Help menu 
Click Open Log File in the Help pull-down menu to generate a log file in Notepad. The 
default log file name is ProtocolManagerLog.txt. 

 

NOTE: Always generate an error log before posting a support request on the forum or 
contacting technical support. 
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Tools menu 
The Tools menu provides access to several support functions. The available Tools 
functions are: 

o Managing organizations 

o Managing references 

o Checking for errors 

 

Managing organizations 
In Protocol Manager, you can apply an organization structure to categorize your 
methods and protocols based on subject, discipline, domain, or other criteria. Protocol 
Manager uses a two-tiered filtering approach that lets you dynamically filter the amount 
of data that you see as you are working. Simply put, you can assign organization groups 
(main categories) and organizations (sub-categories) to your methods and protocols, 
and then, using a filter, view only those methods that belong to a specific organization. 
See Adding organizations and Assigning organizations to methods for more information.  

Protocol Manager is shipped with five default organization groups, which are identified 
along with their organizations in the figure below. You can create more groups as 
needed to meet your requirements, and you can add new organizations to the groups. 
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To manage organization groups and organizations: 

1. In the Tools pull-down menu, select Manage Organizations. 

 
2. The Organization Manager window opens. Click through the Organization Groups 

to view the associated Organizations. 
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3. Use the Organization Group and Organization pull-down menus to make any 

necessary changes. 

 

 100



Adding organization and organization groups 
For information about organization groups and organizations, see Managing 
organizations. 

1. In the Tools pull-down menu, click Manage Organizations. 

2. The Organization Manager opens. In the Organization Group pull-down menu, click 
New. 

 
3. In the Organization Group Builder, enter a name and description for the group and 

click Save & Close. 
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continued

Adding organizations (continued) 
4. Back in the Organization Manager window, click New in the Organization pull-

down menu to add organizations to Test group. 
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5. In the Organization Builder, select the appropriate organization group in the pull-
down menu. Enter a name and description for the organization and click OK 
& Close. 

 

NOTE: Use the Manage Organization tool to edit and delete organizations and groups. 

See Assigning organizations to methods. 

Assigning organizations to methods 
For information about organization groups and organizations, see Managing 
organizations. 

After you add organization groups and organizations, you can assign them to the 
appropriate methods. For example, you can assign the organizations Classification, 
Habitat Quality, Terrestrial, and Field Sample to the method TD-Tree, as shown below. 
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1. In the Method view, select the method. 

2. Select Edit Method by right-clicking the method name or clicking the Edit Method 
icon on the toolbar. 

3. In the Organizations tab, assign the appropriate organizations. 

4. When you are done, click Save & Close. 

Managing references 
The Manage Reference feature lets you enter and update technical references for your 
methods and protocols. To use this feature: 

1. In the Tools pull-down menu, select Manage References. 
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2. In the Reference Manager window, select the reference type (Journals is selected) 

and click New. 

 
3. Enter the reference data and click Save & Close. 
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NOTE: Use the Notes section to indicate whether the reference pertains to a specific 
method or protocol, or whether it is a more general reference. 

4. The new reference is listed in the Reference Manager window. It can be edited or 
deleted. 

 

Checking for errors 
To run error checking and view an error report: 

1. In the Tools pull-down menu, select Check for Errors. 
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2. Protocol Manager immediately runs the internal error checker and displays all 

errors found. You can copy and paste the text into a Word document or text file 
for further review. Close the report when you are finished. 
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